
 NoteBlox: Help Contents
NoteBlox: Start here

NoteBlox: Start Here

NoteBlox: About
About NoteBlox
About OLE
About ToolBlox
About AlphaBlox

NoteBlox: Commands
File Menu
Edit Menu
Blox Menu
Help Menu
Control Menu
Shortcut Keys

NoteBlox: How to . . .
Launching NoteBlox from ToolBlox
Creating a NoteBlox on the Desktop

Using Templates
Creating Your Own Templates

OLE: Embedding a NoteBlox in a Document
OLE: Embedding or Linking an Existing NoteBlox
OLE: Embedding an Object in a NoteBlox
OLE: Switching between Icon and Content Display
OLE: Tracking NoteBlox

Formatting NoteBlox
Finding Text in a NoteBlox
Replacing Text in a NoteBlox
Printing NoteBlox
Mailing NoteBlox
Saving NoteBlox as Files

Microsoft Office Compatible
Microsoft Office Compatible



 NoteBlox: the Basics

For a description of any component, click on that component in the picture below (a tool button or menu, 
for example).



 About NoteBlox

NoteBlox the electronic stick-on note 
NoteBlox is a simple, fast, and flexible tool for creating notes telephone messages, memos, reminders, 
document annotations and comments, etc.

with full OLE functionality. 
It is the electronic equivalent of the stick-on note, allowing you to create notes quickly and easily and to 
place them wherever you want. There is no need to launch a large application and work through menus 
and dialogs, nor do you need to specify a filename for the NoteBlox or to search directories and files to 
retrieve it. 
Like the stick-on note, a NoteBlox can be attached directly to a document at the precise location at which 
it is needed. Alternatively, you can create it directly on the desktop so that it is readily available at all times

when you no longer need it, simply drag it to the Recycle Bin. You can also send your NoteBlox to other
people in a few short steps, via the electronic mail component of Windows 95.
        NoteBlox Features



 NoteBlox Features

NoteBlox is quick and easy to use, but it also has advanced features that make it a powerful and 
adaptable note tool: 

Creating Notes: Create notes of any type quickly and easily
telephone notes, memos, reminders, document annotations and comments, meeting notifications, 

appointments, etc.
Templates: NoteBlox is delivered with a set of templates which provide predefined headings for 

notes of various types. To create a NoteBlox, load the template and then fill in your own text next to the 
template headings. 

Templates are fully customizable; and you can also save your own note layouts as templates for 
future reuse. Browsing around the supplied templates will give you an idea of the range of applications for
NoteBlox.

OLE: NoteBlox have full OLE functionality. You can embed them them into documents or other 
objects simply by dragging the NoteBlox icon from ToolBlox and dropping it in place

you have the choice of displaying the NoteBlox as icons or as displayed text, and of editing embedded 
NoteBlox either in place or in separate windows. You can also create OLE links between NoteBlox and 
other applications. For ease of access, you can place NoteBlox directly on the desktop or you can store 
them in your WorkBlox. 

NoteBlox can also act as containers for other objects such as spreadsheets, CalcBlox calculations, 
and ListBlox lists. Again simply drag the object from ToolBlox and drop it into place, or use the Insert 
New Object command on the Edit menu.

Automatic Titles, Date Stamp, and Author Recognition: NoteBlox are automatically titled and 
stamped with the date, time, and author's name. If you wish you can change the title to one of your own 
choice. Dates and times are automatically updated whenever you modify the NoteBlox.

Formatting and Color Coding: Apply different font type, style, size, and color to NoteBlox text. 
Color code NoteBlox backgrounds to indicate different types, uses, or priorities. 

NoteBlox Files: Using standard File menu commands, save NoteBlox as standalone files in 
either NoteBlox or Text format.

Mail Notes: Send your NoteBlox to other people using the electronic mail component of Windows
95, accessed via the NoteBlox File | Send command. The NoteBlox and any embedded objects are sent 
to the specified receivers. You can also fax your NoteBlox using Microsoft Fax.

Tracking NoteBlox and Documents: Keep track of your NoteBlox and of their container 
documents using the shortcuts feature of Windows 95. Or use WorkBlox to store, organize, and track 
NoteBlox.



New
Creates a new NoteBlox in the NoteBlox window. If you already have a NoteBlox open, you are prompted 
to save it as a file.



Open
Opens a NoteBlox that you have previously saved as a file. You specify the filename and the folder where
it is located, and the NoteBlox is then displayed in the NoteBlox window.
You can specify either NoteBlox (*.nbx) or Text files (*.txt) for the type of file to open.



Save
Saves a NoteBlox to its current filename and folder. You are prompted for a filename if you have not 
previously saved the NoteBlox as a file.



Template
Use to create a NoteBlox based on a particular template. The Template dialog box presents all existing 
NoteBlox templates and you select the one you want by double-clicking on it or by clicking on it and 
choosing OK.



Always on Top
Click this button if you want NoteBlox always to appear on top of other windows on your desktop.



Drag Note
To embed the current NoteBlox into another application or object, click this button and drag to the desired 
location.



Drag-Link
To create a link to the current NoteBlox in another application or object, click this button and drag to the 
desired location. The button is available only for NoteBlox that have been saved as files.



Background Color
Use to set the background color of a NoteBlox.



Undo
Reverses your last editing action. For example, if you delete some text from a NoteBlox by mistake, you 
can restore it immediately afterwards by clicking the Undo button.



Time and Date
Inserts the current time and date in your NoteBlox.



Find
Use to find a particular text string in your NoteBlox.
To replace a particular text string with another, use the Replace command on the Edit menu.



Title
The title of the current NoteBlox. This is taken automatically from the first line of the text. To enter a 
different title, click on the title edit box and type the new title.



Date Stamp
This records the time and date that the NoteBlox was last edited.



Text Area
The area where you type the content of your NoteBlox. To change the background color, use the 
Background Color button. To change text attributes, use the Blox | Options command.



Status Bar
The status bar is displayed at the bottom of the NoteBlox window. The left part of the status bar displays a
description of the function of menu items and toolbar buttons as you move the mouse pointer over them. 
The right part of the status bar indicates whether the following keys are currently on or off: CAP (Caps 
Lock key is on), NUM (Num Lock key is on), SCRL (Scroll Lock key is on).



Caption Bar
This displays file name of the current NoteBlox and the NoteBlox application name. 
Minimize, Maximize, and Close buttons are included at its right-hand side, the control menu button at its 
left-hand side. 
To move the NoteBlox window, drag the title bar. 



Scroll Bar
If the NoteBlox window is not large enough to display your entire text, use the scroll bar to scroll to the 
parts not currently displayed. You can scroll by dragging the scroll box, by clicking the scroll arrows, or by 
pressing the PgUp, PgDn, or Arrow keys on your keyboard.



 About OLE

OLE (Object Linking and Embedding) is a mechanism that allows applications to integrate seamlessly. 
Documents can contain objects of many different types, created by different applications, and the objects 
have associated with them not only the data necessary to display them but also the information needed to
edit them. The host document is the container; the application that created the object is the server.
Linking and Embedding 
Using OLE you can choose to embed or link an object into a container. 
Embedded objects are stored in your document, and can be edited using the tools and controls of their 
applications. You simply double-click on an object to activate and edit it. When you send an embedded 
object to other people, they too can view and edit it.
With linked objects, only the display data is included in the container, together with a link to the original 
data. When the original object is updated, so is the linked object. And when you double-click on the linked
object, the original document is immediately launched ready for editing.
In-place (or Visual) Editing 
You can edit an embedded object either in place or in a separate window. Simply double-click on the 
object to activate it. With in-place editing, you edit the object without leaving the container document. The 
necessary menus and tools temporarily replace or supplement those of the container application. Click 
back on the container and its menus and tools reappear. 
Drag-and-Drop 
Drag-and-drop is a fast and intuitive method of moving objects within and across applications. Point to the
object, press and hold down the left mouse button while dragging the object into place, then release the 
button. To move data, first select it and then follow the same steps. 

Move an object or selected data Drag-and-drop 
Create a copy of the object or data CTRL+Drag-and-drop 
Create a linked copy of the object or data CTRL+SHIFT+Drag-and-drop
Icon or Content Display 
You can display OLE objects either with their content visible or as icons. To switch modes, right-click on 
the inactive object; then choose Display Content or Display as Icon from the pop-up menu. When creating
an object directly from ToolBlox, you can create it in either mode. Objects displayed as icons are 
automatically edited in separate windows; objects with content displayed are automatically edited in 
place.
Note: Only OLE2-compliant applications can exchange information with AlphaBlox OfficeBlox objects 
using linking and embedding and drag-and-drop techniques.



 About ToolBlox

ToolBlox is your point of access for creating NoteBlox. It is a powerful, customizable toolbar that provides 
fast access to AlphaBlox objects and to other frequently-used applications such as Microsoft Word or 
Excel. A distinguishing feature is that not only can you use it to launch applications but you can also 
create objects directly from it with a single click. 

To launch NoteBlox or any other application included on ToolBlox, simply click on its icon.
To launch NoteBlox with a particular template in place, click the Template icon on ToolBlox. Then 

double-click on the particular template you want to use.
To create an object directly in a container document or on the desktop, drag the object's icon from

ToolBlox to the desired position. You can then activate and work with the object by double-clicking on it. 
You can drag the object as an icon or as an in-place object. The default is set in the ToolBlox preferences,
but there are also keyboard shortcuts. To create an in-place object, press CTRL while dragging the object 
into position; to create an iconized object, press SHIFT instead. 

To add an application to ToolBlox, use Explorer to locate the executable file (WINWORD.EXE for 
example), and drag it into position on ToolBlox. AlphaBlox objects are automatically added to ToolBlox 
when you install them. 

To change ToolBlox preferences, click on the ToolBlox Configure icon. Then use the Preferences 
options to change attributes such as the size and layout of icons and whether objects are embedded by 
default as icons or as in-place objects. 

When ToolBlox is the active task, you can switch between its normal size and a captionized version by 
pressing ESC.



 About AlphaBlox

NoteBlox is one of a suite of OfficeBlox components from AlphaBlox Corporation which gives you quick 
and easy access to frequently-used items such as notes, calculations, and lists. Many other components 
already available, under development or planned.
Providing full OLE support, all components integrate seamlessly with each other, with the desktop, and 
with other OLE-compliant applications they can be combined in whatever way suits your needs, and are 
available wherever and whenever required. 
All AlphaBlox tools are designed to be simple, quick, easy, adaptable, compact and affordable. A 
consistent interface style across the components, and the use of common tools for common tasks, 
contributes to more intuitive interaction with the tools.



 Launching NoteBlox from ToolBlox

To launch NoteBlox from ToolBlox, click on the NoteBlox icon.
To launch NoteBlox with a particular template in place, click the Template icon on ToolBlox, and 

then double-click on the template you want to use.
To embed a NoteBlox object directly from ToolBlox, drag the NoteBlox icon into position on the 

desktop or in a container document.



 Creating a NoteBlox on the Desktop

1 Drag NoteBlox from ToolBlox onto the desktop. It is displayed there as a Scrap icon.
2 Double-click on the Scrap icon to activate NoteBlox. The NoteBlox window is displayed.
3 Type your message in the text area. Use the Blox | Options command to change the font and color 

attributes of the NoteBlox text and to change the background color. You can also change the 
background color using the Background Color tool on the NoteBlox toolbar.

4 When you have finished creating the NoteBlox, click the Close button to close it.
5 You can now double-click on the Scrap icon at any time to read or edit the note. 
6 You can give the Scrap icon a more meaningful name simply by clicking on the current name and 

then typing the new one.
You can also create a NoteBlox on the desktop by right-clicking on the desktop and then choosing the 
New | AlphaBlox NoteBlox Document option from the pop-up menu displayed.



 Using Templates

A NoteBlox template consists of a NoteBlox with a predefined set of headings or predefined text that you 
can use as the starting point for other NoteBlox. The background color and the font and color attributes of 
the text are also part of the template.
To create a NoteBlox using a particular template, click the Template tool on the NoteBlox toolbar or on 
ToolBlox. This displays the Template dialog box which lists all available templates. Simply double-click on 
the template you want, or select it and click OK. 
You can also access the Template dialog box using the Apply Template command on the File menu. To 
launch NoteBlox from ToolBlox with a particular template in place, click the Template icon on ToolBlox, 
then double-click on the template you want to use.
Three buttons are included for changing the way the templates are displayed in the Template dialog box
the three views are: Icons, List, and Details. When you choose the Details option, full details of each 
template are displayed (name, size, type, and date and time last modified).



 Creating Your Own Templates

1 Create a new NoteBlox.
2 Enter the headings or text you want included in the template.
3 Set the background color and the font and color attributes of the text.
4 Choose the Save As Template command from the File Menu.
5 In the Save As dialog box, open the template directory where you want to save the template, enter 

a name for the template, and then choose the Save button. This saves any text in the NoteBlox, 
and also the NoteBlox properties and font and color attributes, as a template for future NoteBlox.

6 You can now use the Template button on the toolbar or on ToolBlox to open your template and use 
it as the basis for a new NoteBlox.



 Embedding a NoteBlox in a Document

1 Open the document you want to annotate.
2 From ToolBlox, drag NoteBlox into position in the document.
3 Double-click on the NoteBlox to activate it.

If the NoteBlox is displayed as an icon, it opens in a separate window and you enter your text there.
Click the Close button when finished.
If the NoteBlox is displayed with its content visible, the NoteBlox is edited in place. For example, 
when you activate a NoteBlox that is included in Microsoft Word, the Word menus and tools are 
replaced or supplemented by those you need to edit your NoteBlox. When you are finished, click 
back on the Word document and the Word menus and tools reappear.

4 To switch between displaying the NoteBlox as an icon or as content, right-click on the object and 
choose Display as Icon or Display Content from the pop-up menu. Alternatively, use the Object | 
Convert command on the container application's Edit menu and select or deselect the Display as 
Icon option, as appropriate.



 Embedding or Linking an Existing NoteBlox

To embed an existing NoteBlox into a document or object, click on the Drag Note button on the NoteBlox 
toolbar and drag to the document or object you want to annotate. This creates an independent copy of the
NoteBlox in the container document. You can then double-click on the NoteBlox to activate and edit it.
To create a link in another document or object to an existing NoteBlox, click on the Drag-Link Note button 
and drag into place. Whenever the original NoteBlox is updated, the linked NoteBlox is updated also. And 
you can edit the original NoteBlox by double-clicking on the linked NoteBlox.
Note that you must save the NoteBlox as a file before you can create a link to it.



 Embedding an Object in a NoteBlox

For example, to embed a CalcBlox in a NoteBlox:
1 Create or open the NoteBlox.
2 From ToolBlox, drag CalcBlox into the NoteBlox. Or use the Insert New Object command on the 

NoteBlox Edit menu.
3 Double-click on the CalcBlox to activate it.

If the CalcBlox is embedded as an icon, or if it is embedded in a NoteBlox that itself is embedded in
another document, CalcBlox is launched in a separate window. Otherwise it is edited in place.

4 Enter your data.
5 If editing in a separate window, click the Close button when finished. If editing in place, click back 

on the NoteBlox to continue.
6 To switch between displaying the CalcBlox as an icon or as content, right-click on the object and 

choose Display as Icon or Display Content from the pop-up menu. Alternatively, use the Object | 
Convert command on the NoteBlox Edit menu.



 Switching Between Icon and Content Display

You can display OLE objects either with their content visible or as icons. To switch modes, right-click on 
the inactive object; then choose Display Content or Display as Icon from the pop-up menu. Alternatively, 
use the Object | Convert command on the container application's Edit menu.
When creating an object directly from ToolBlox, you can create it in either mode. 
Objects displayed as icons are automatically edited in separate windows; objects with content displayed 
are automatically edited in place.



 Tracking NoteBlox

If you have a NoteBlox embedded in a document or other object, you can create a shortcut to it anywhere
on your system and use it for quick access to the NoteBlox and its container.
To create a shortcut on the desktop, follow these steps:

1 Right-click on the NoteBlox and choose Copy from the pop-up menu.
2 Right-click on the desktop and choose Paste Shortcut from the pop-up menu. A shortcut icon is 

created with a link to the NoteBlox.
3 Close the container document.
4 You can now double-click on the shortcut icon whenever you wish to view the NoteBlox again. The 

container document is immediately opened at the point where the NoteBlox is located.
You can also use WorkBlox to track NoteBlox objects.



 Formatting NoteBlox

The Blox | Option command enables you to change certain attributes of your NoteBlox, such as the 
background and foreground colors and the font, font style, and font size. 
Choosing the command displays the Options dialog box where you specify the settings you want to use.
You can also use the Background Color tool on the NoteBlox toolbar to change the background color. And
you can use the Time and Date button to insert the current time and date into your text.



 Printing NoteBlox

Use the File | Print command to print the current NoteBlox. You can choose to print it to the default printer,
to any other printer set up on your system, or to a file. You can also specify which pages to print and the 
number of copies required.
Use the File | Print Preview command to see how the NoteBlox will look when printed.
Use the File | Print Setup command to change certain print options such as paper size and orientation, 
the printer to use, and the properties of that printer.



 Mailing NoteBlox

Use the File | Send command to mail a NoteBlox to other people via the electronic mail component of 
Windows 95. The NoteBlox and any embedded objects are sent to the specified receivers.



 Saving NoteBlox as Files

When you create a NoteBlox that is not embedded on the Desktop or attached to another 
document or object, you can save it as a file for future access. Use the File | Save As command. 

When you subsequently edit the file, you can save your changes using the File | Save command 
or the Save button on the toolbar.

When you want to save an embedded or linked NoteBlox to a file, use the File | Save Copy As 
command. This saves a copy of the NoteBlox to a specified file.

To open a NoteBlox you have previously saved to file, use the File | Open command or the Open 
button on the toolbar.



 File Menu

New Creates a new NoteBlox in the NoteBlox window. You are 
prompted to save the current NoteBlox if you have made 
changes to it that you have not already saved.

Open Opens an existing NoteBlox file. In the Open dialog, you 
specify the name of the file and its location. Then click Open
to open it.

Save Saves the current NoteBlox to its current filename and 
folder.

Save As Saves the current NoteBlox under a specified name. In the 
Save As dialog box, you specify a name for the file and a 
location. Then click Save to save it.

Apply 
Template

Creates a new NoteBlox with a particular template in place. 
When the Template dialog box appears, select a template 
and then click OK to display it in the NoteBlox window.

Save As 
Template

Saves the current NoteBlox as a template for future reuse. 
In the Save As dialog box, enter a name for the template 
and then click the Save button.

Print Prints the current NoteBlox. You can choose to print it to the
default printer, to any other printer set up on your system, or
to a file. You can also specify which pages to print and the 
number of copies required.

Print 
Preview

Displays the NoteBlox as it will appear when printed.

Print 
Setup

Use to change certain print options such as paper size and 
orientation, the printer to use, and the properties of that 
printer.

Send Sends a NoteBlox to other people via the electronic mail 
component of Windows 95.

1, 2, 3, 4 Reopens the most-recently closed NoteBlox files. 
Exit Exits NoteBlox. 



 Edit Menu

Undo Reverses your most recent editing action. 
Cut Deletes selected data, placing it on the clipboard.
Copy Copies selected data to the clipboard.
Paste Inserts the clipboard contents into your NoteBlox. 
Paste Link Inserts the clipboard contents into your NoteBlox, and 

creates a link between the data in the NoteBlox and the 
source data.

Clear Deletes selected data, without placing it on the 
clipboard.

Select All Selects the entire contents of the NoteBlox so that you 
can subsequently Cut or Copy it.

Find Use to find a particular text string in your NoteBlox.
Replace Use to replace a particular text string with another text 

string.
Insert Time 
and Date

Inserts the current time and date in the NoteBlox.

Insert New 
Object

Inserts a new or existing object into a NoteBlox. You can
insert the object as an icon or with its content displayed. 
You can also choose either to embed the object or to 
create a link to an existing file.

Links Lists any OLE links included in the current NoteBlox and
enables you to edit them.

Object This command becomes available when you click on an 
object in a NoteBlox. The name of the command differs 
depending on the type of object selected for example, 
Microsoft Excel Worksheet Object, CalcBlox Object, 
ListBlox Object.
Choosing the command displays the Object submenu.

Object | 
Open

Opens the selected object in a separate window, ready 
for editing.

Object | Edit Activates a selected object ready for in-place editing. 
The menus and tools required are added to the 
NoteBlox menubar and toolbar.

Object | 
Convert

Enables you to convert a selected object to a different 
object type (where relevant), and also to switch between
displaying the object as an icon or as content.



 Blox Menu

View Displays a submenu from which you can choose which 
components of the NoteBlox window are displayed (for 
example, tool bar, dialog bar, and caption bar). 
The Toolbar Properties option allows you to change certain 
attributes of the toolbar, such as the size of the buttons and 
whether they are displayed in color or black and white.

Options Provides options for changing certain NoteBlox attributes (for 
example, background and foreground colors, fonts, and 
template directory).



 Help Menu

NoteBlox Help 
Topics

Opens the NoteBlox online help window.

About NoteBlox Displays NoteBlox version and copyright details.



 Template

The Template dialog box lists all available NoteBlox templates and enables you to create a new NoteBlox 
with a selected Template in place. 
Simply double-click on the template you want, or select it and click OK. 
Three buttons are included for changing the way the templates are displayed in the dialog box. The three 
available views are: Icons, List, and Details. When you choose the Details option, full details of each 
template are displayed (name, size, type, and date and time last modified).



 Save As Template Dialog Box

Use the File | Save As Template command to save a NoteBlox as a template for future NoteBlox. The 
Save As Template dialog box presents the following options:

Save In
Identifies the current folder. The templates currently in that folder are listed in the box below. 
To view how the current folder fits in the hierarchy of folders on your computer, click the down arrow. To 
open one of those folders, simply click on it its contents are then shown in the list below.
Double-clicking on an existing file name in the list saves the template to that file, overwriting the current 
contents of the file. 
File Name
Use to specify a name for the template you want to save. You can specify a full path for the file if you 
wish. If you have selected a file in the list above, its name is automatically entered here.

Save as Type
Specifies the type of file you are saving. NoteBlox Template (*.ntx) is the default option. 

Toolbar
The following tool buttons appear at the top of the dialog box:
Up One Level: Opens the folder one level higher than the current one.
Create New Folder: Creates a new folder in the current one.
List: Lists files and folders with their icons and names only.
Details: Lists files and folders with their icon, name, file size, file type, and date last modified.

Save button
Click to save the template to the specified filename and location. If you specify the name of an existing 
file, the current contents of that file will be overwritten. 

Cancel button
Click to close the dialog box without saving the template.

See Also Template Directory



 Options Dialog Box

Use the Blox | Options command to change NoteBlox attributes. The Options dialog box presents the 
following options:

This Note
Font
Displays the Font dialog box which you can use to change the font attributes of your NoteBlox text (for 
example, font, font style, font size, and color).

Color
Displays the Color dialog box which you can use to change the background color of the NoteBlox.

Example
Displays sample text in the currently selected background and foreground colors and font.

Word Wrap
Turns word wrapping on or off. 
When word wrap is off, you must press ENTER to move to the next line. And the text may be truncated 
when you reduce the window size.
When word wrap is on, your text automatically wraps to the next line when it reaches the right edge of 
the text area. When you resize the NoteBlox window, the text is rearranged to fit the new window size.

Scroll Bar
Displays or hides the NoteBlox scroll bar.

Set Default
Sets the current options (font, color, word wrap, etc.) as the default settings for future NoteBlox.

Save Summary Information
When this option is selected, summary information (title, author, keywords, comments, etc.) is saved 
with the NoteBlox. You are prompted to update these details whenever you close the NoteBlox. 

OK, Cancel
Choose OK to implement any changes you have made in the Options, Font, or Color dialog boxes. 
Choose Cancel instead to abandon your changes.



 Control Menu

Restore Returns the NoteBlox window to its size and position 
before you chose the Maximize or Minimize command.

Move Enables you to move the NoteBlox window using the 
arrow keys. Choosing the command displays a four-
headed arrow, and you simply press the arrow keys on 
your keyboard to move the window around the screen. 
Press ENTER when finished.

Size Enables you to size the NoteBlox window using the arrow 
keys. Choosing the command displays a four-headed 
arrow. First press the arrow key (up, down, left, or right) 
that corresponds to the border you want to move; then 
press the appropriate arrow keys to move that border in 
the desired direction. Press ENTER when finished.

Maximize Enlarges the NoteBlox window to fill the entire screen.
Minimize Reduces the NoteBlox window to an icon on the taskbar.
Close Exits NoteBlox.



 Open Dialog Box

Use the File | Open command to open an existing NoteBlox. The Open dialog box presents the following 
options:

Look In
Identifies the current folder. The contents of that folder are listed in the box below.
To view how the current folder fits in the hierarchy of folders on your computer, click the down arrow. To 
open one of those folders, simply click on it its contents are then shown in the list below.
To open one of the files or folders listed, double-click on it. 
File Name
Use to specify the name of the file you want to open this can include the full path for the file. You can 
include * as a wildcard to filter the files displayed in the list above. If you have selected a file in this list, its 
name is automatically entered here.

File of Type
Specifies the type of file to be listed in the dialog box. NoteBlox Document (*.nbx) indicates NoteBlox files 
and is the default option. NoteBlox also supports ASCII text files, and you can specify this type of file by 
selecting the Text Files (*.txt) option.

Toolbar
The following tool buttons appear at the top of the Open dialog box:
Up One Level: Opens the folder one level higher than the current one.
Create New Folder: Creates a new folder in the current one.
List: Lists files and folders with their icons and names only.
Details: Lists files and folders with their icon, name, file size, file type, and date last modified.

Open button
Click to open the file specified in the File Name box. 

Cancel button
Click to close the dialog box without opening a file.



 Save As Dialog Box

Use the File | Save As command to save a NoteBlox to a specified filename and location. The Save As 
dialog box presents the following options:

Save In
Identifies the current folder. The contents of that folder are listed in the box below. 
To view how the current folder fits in the hierarchy of folders on your computer, click the down arrow. To 
open one of those folders, simply click on it its contents are then shown in the list below.
Double-clicking on an existing file name in the list saves your NoteBlox to that file, overwriting the current 
contents of the file.
File Name
Use to specify a name for the file you want to save. You can specify a full path for the file if you wish. If 
you have selected a file in the list above, its name is automatically entered here.

Save as Type
Specifies the type of file you are saving. NoteBlox Document (*.nbx) is the default option. NoteBlox also 
supports ASCII text files, and you can specify this type of file by selecting the Text Files (*.txt) option. Note
that embedded objects and NoteBlox color and font attributes are not saved when you select the Text 
Files option.

Toolbar
The following tool buttons appear at the top of the dialog box:
Up One Level: Opens the folder one level higher than the current one.
Create New Folder: Creates a new folder in the current one.
List: Lists files and folders with their icons and names only.
Details: Lists files and folders with their icon, name, file size, file type, and date last modified.

Save button
Click to save your NoteBlox to the specified filename and location. If you specify the name of an existing 
file, the current contents of that file will be overwritten. 

Cancel button
Click to close the dialog box without saving the file.



 Print Dialog Box

Use the File | Print command to print the current NoteBlox. The following options allow you to specify how
the document should be printed:

Printer
This section provides information about the currently selected printer.
Name: Identifies the currently selected printer. To use a different printer, click on the down arrow and 
select a printer from the list displayed.
Properties: Use this to change the options for the currently selected printer. The options available depend 
on the type of printer it is.
Print to File: Prints the NoteBlox to a file instead of to the printer. You are prompted for the filename and 
location.

Print Range
Use to specify whether you wish to print the entire NoteBlox, a particular range of pages only, or the 
currently selected text only.

Copies
Number of Copies: Specify here the number of copies you want to print. 
Collate: If you are printing more than one copy, use this option to specify whether or not you want the 
copies to be collated.

OK button
Click to print the NoteBlox.

Cancel button
Click to abandon the print job.



 Print Preview Dialog Box

Use the File | Print Preview command to display the current NoteBlox as it would appear when printed. 
When you choose this command, the main NoteBlox window is replaced with a print preview window in 
which one or two pages are displayed in their printed format. The print preview toolbar offers the following
options:

Print Displays the Print dialog box so that you can send the 
NoteBlox to print.

Next Page Preview the next page.
Prev Page Preview the previous page.
One Page/
Two Page

Preview one or two pages at a time.

Zoom In Zoom in to take a closer look at the page.
Zoom Out Zoom out to view the entire page(s).
Close Return from print preview to the main NoteBlox window.



 Print Setup Dialog Box

Use the File | Print Setup command change print settings.

Printer
This section provides information about the currently selected printer. 
To use a different printer, click the down arrow beside the Name box and select a printer from the list 
displayed.
To change the properties of the currently selected printer, click the Properties button. The options 
available depend on the type of printer it is.

Paper
Use to specify the paper size and source.

Orientation
Use to specify the paper orientation: Portrait or Landscape.

OK button
Click to implement any changed settings.

Cancel button
Click to abandon any changes you made.



 Insert Object Dialog Box

Use the Edit | Insert New Object command to insert a new or existing object into a NoteBlox. The object 
can be inserted as an icon or with its content displayed, and can be either linked or embedded. To 
activate and edit the object, simply double-click on it. 
The Insert Object dialog box presents the following options:

Create New
Embeds a new object of the specified type into the current NoteBlox. You specify the object type by 
selecting the appropriate option in the Object Type list.

Create from File
Embeds or links an existing file into the current NoteBlox. You specify the file you want by typing its name 
in the File box. Alternatively, you can use the Browse button to browse through the files and folders on 
your computer until you find the file you want then double-click on it to enter its name in the File box.
Select the Link option to specify that you want to link the file instead of embedding it. If you link the file, 
the copy of the file in your NoteBlox is linked to the original source file and is updated whenever the 
source file is updated. If you embed the file, a separate copy is inserted in your NoteBlox with no links to 
the source file. 
Display as Icon / Change Icon
Select Display as Icon to display the object in your NoteBlox as an icon instead of with its content 
displayed. When you select this option, the default icon is displayed and also a Change Icon button which
allows you to specify a different icon and icon label.

Result
Describes the result of using the current settings when you insert an object. 

OK button
Click OK to insert the specified object or file into your NoteBlox using the currently selected settings. 

Cancel button
Click Cancel to close the dialog box without inserting an object.



 Convert Dialog Box

Use the Edit | Object | Convert command to convert a selected object to a different file type, to activate it 
using an application other than its original application, or to switch between displaying the object as an 
icon or content. The Convert dialog box presents the following options: 

Current Type
Indicates the current file type.

Object Type
Lists the file types to which the object can be converted, or which it can be activated as.

Convert to
Click this to convert the object to the file type selected in the Object Type list.

Activate as
Click this if you want to edit the object using an application other than its original application. Select the 
required application in the Object Type list the selected application must support the particular object 
type. 

Result
Describes the result of implementing the current settings.

Display as Icon / Change Icon 
Select Display as Icon to display the object in your NoteBlox as an icon instead of with its content 
displayed. When you select this option, the default icon is displayed and also a Change Icon button which
allows you to specify a different icon and icon label.

OK button
Click OK to implement your selections. 

Cancel button
Click Cancel instead to close the dialog box without implementing your selections.



 Links Dialog Box

Use the Edit | Links command to list and edit any OLE links included in your NoteBlox. The Links dialog 
box presents the following options:

Links
Lists the links included in your NoteBlox, together with their type and update status.

Source / Type
Indicates the source and file type of the currently selected link.

Update
Use to specify whether you want links to be updated automatically or only on request.

Update Now
Click this to update the currently selected link.

Open Source
Click this to open the source file for the currently selected link.

Change Source
Click this to specify a different source file for the currently selected link. 

Break Link
Click here to disconnect the currently selected link. This is useful if you no longer want changes in the 
source file to be reflected in your NoteBlox.



 Font Dialog Box

Use the Blox | Options | Font command to change the font attributes of NoteBlox text.

Font
Lists all available fonts and indicates the currently selected one. To change to a different font, select the 
new font from the list.

Font Style and Size
Lists the available font styles and sizes for the currently selected font, and indicates the currently selected
options. To change to a different style or size, select the desired options from the relevant list.

Effects
Use to specify whether the text should be striked out and/or underlined, and the color in which it should 
be displayed.

Sample
Displays sample text using the settings currently selected in the Font dialog box.

Script
Lists the available language scripts for the currently selected font, and enables you to select the one you 
want to use.

OK button
Click OK to implement any changes you have made. 

Cancel button
Click Cancel instead to close the dialog box without implementing the changes.



 Color Dialog Box

Use the Blox | Options | Color command, or click on the Color tool in the NoteBlox toolbar to change the 
background color for the NoteBlox. The Color dialog box presents the following options;

Basic Colors
Presents the basic colors available. To select a particular color, simply click on it.

Custom Colors
Displays any custom colors you have previously defined. To edit a custom color, click on it, click on the 
Define Custom Colors button, make your changes, and then click the Add to Custom Colors button.

Define Custom Colors
Click here to define or edit custom colors. To define a custom color, click on the required color in the color 
matrix and then use the slider at the right side of the matrix to adjust the color's attributes. Alternatively, 
specify precise settings for the color using the Hue/Saturation/Luminosity or Red/Green/Blue options.

Add to Custom Colors
When you have defined a custom color, click here to display it in the Custom Color palette on the left of 
the dialog box.

OK button
Click OK to implement the changes you have made. 

Cancel button
Click Cancel instead to abandon your changes.



 Find Dialog Box

Use the Find button on the NoteBlox toolbar to find a particular text string in a NoteBlox.

Find What
Enter here the text you want to find. 

Match Case
Select this option if you want to find only those occurences of the text string that match exactly the case of
your search term.

Direction
You can search up or down through the NoteBlox from your current postion. Use these option to specify 
which.

Find Next
Click to find the next occurrence of the search term.

Cancel
When finished your search, click here to return to NoteBlox.



Template Directory
The default directory where templates are stored is specified by the Template Folder option in the 
ToolBlox Preferences dialog box (click on the ToolBlox Configure icon on ToolBlox to access this). All 
templates stored in this directory appear on the General tab in the Template dialog box.
The other tabs in the Template dialog box correspond to subdirectories of this directory. When you are 
creating your own template, save it to the default template directory if you want it to appear on the 
General tab. Otherwise, save it to the subdirectory that corresponds to the tab on which you want to place
it. 
To add your own tab to the Template dialog box, simply create a subdirectory for it under the main 
template directory.



 Replace Dialog Box

Use the search for and replace a particular text string with another text string.

Find What
Enter here the text you want to replace. 

Replace With
Enter the replacement text here.

Match Case
Select this option if you want to find only those occurences of the text string that match exactly the case of
your search term.

Find Next
Click to find the next occurrence of the text string.

Replace
Click to replace the currently selected occurrence of the text string in the Find What box with that in the 
Replace With box.

Replace All
Click to replace all occurrences of the text string in the Find What box with that in the Replace With box.

Cancel
When finished your search, click here to return to NoteBlox.



 Shortcut Keys

Command Shortcut Key
New CTRL+N
Open CTRL+O
Save CTRL+S
Print CTRL+P
Undo CTRL+Z
Cut CTRL+X
Copy CTRL+C
Paste CTRL+V
Select All CTRL+A
Insert Date and 
Time

F5



Microsoft Office Compatible

Microsoft Office Compatible
NoteBlox is a Microsoft Office compatible product, which means that its toolbars, menus, and accelerator 
keys are similar to those used by Microsoft Office. If you are already using Microsoft Office, which 
includes Microsoft Excel, Word, Microsoft Access and Powerpoint, then many of the tasks you have 
learned to complete in Office can be completed in a similar manner in NoteBlox. AlphaBlox and Microsoft 
hope these similarities will make it easier for you to use our products together and with other Microsoft 
Office Compatible products.
Look for the Microsoft Office Compatible logo when purchasing software. For more information about the 
Microsoft Office Compatible program, and for a complete listing of Microsoft Office Compatible products, 
in the United States, call Microsoft Customer Service at 1-800-426-9400. Customers outside the United 
States should contact their local Microsoft office. 

NoteBlox and the Office Compatible Features
The skills that you have acquired while using Microsoft Office are applicable to NoteBlox. You will find in 
NoteBlox a menu and toolbar arrangement that is very similar to those of Office and the techniques you 
use for navigating around the application are the same. 
For example, to open a NoteBlox, click on the Open button on the toolbar, and to save a NoteBlox, click 
on the Save button. Of course, you can also use the Open and Save options on the File menu to achieve 
the same results. To discover the function of each button on the NoteBlox toolbar, just position the mouse 
pointer over the button and the tooltip for that button is displayed.

OLE Enhancements
The NoteBlox toolbar includes two buttons (Drag Note and Drag Embed) that offer enhanced OLE 
functionality.

Use the Drag Note button to embed the current NoteBlox in a container document.
Use the Drag Link button to link the current NoteBlox into a container document.

Toolbar Button Differences
Not all of the Office functions are placed on the toolbar.    The reason for this difference is that NoteBlox is 
a compact product designed to fit into and complement your Office and other applications and so the 
toolbar has been kept to a minimum size, in order to keep the window width and height to the smallest 
and most useful dimensions.    The functions are, of course, all available from menus and shortcut keys.
In particular, you can access Cut, Copy and Paste via the Edit menu or by using the standard accelerator 
keys, these being Control X for Cut, Control C for Copy and Control V for Paste.

Using NoteBlox with Microsoft Office
NoteBlox incorporates full OLE functionality, and you can integrate it directly with Microsoft Office. For 
example, you might want to annotate a Word report by embedding a NoteBlox into it, or you might want to
annotate an Excel spreadsheet.
The are a number of ways in which you can integrate Office applications with NoteBlox (and indeed other 
OfficeBlox applications). Some of the tasks that you can perform are described below.

Embedding a NoteBlox in a Word Document
You can embed both new and existing NoteBlox into a Word document.

To embed a new NoteBlox in a Word document, open the document within which you want to 
place the NoteBlox and from ToolBlox, drag NoteBlox into position in the document.

To embed a previously created NoteBlox, open it and then use the Drag Note tool to drag it into 
position in the document. Once the NoteBlox is in position in the document, double-click on it to activate 
it.



Linking a NoteBlox to an Excel Spreadsheet
To link a NoteBlox, open it and then use the Drag Link tool to drag it into position in the target document.
Note: You must save a NoteBlox as a file before you can link it to an Office application, as OLE linking works 
only from saved files.

Embedding and Linking Office Documents in a NoteBlox
As well as embedding and linking NoteBlox in Office documents, you can also embed and link Office 
documents in a NoteBlox. For example, you could have a memo about a proposal costing you can include
in it the Excel spreadsheet with details of the costing. You could either embed or link the spreadsheet into 
the NoteBlox. To do this, use the Insert New Object command on the Edit menu. 




